
Conduct of Written Test for the posts of Forester,
Forest Guard and Excise Constable under CRE
2025 II

Candidate
Application Photo

Candidate
Registration Photo

* Note
Correct Answer will carry 1 mark per Question.
Incorrect Answer will carry 0.25 Negative mark per Question.

1. Options shown in green color with a tick icon are correct.
2. Chosen option on the right of the question indicates the option selected by the candidate.

5/16/26, 11:35 AM cdn3.digialm.com//per/g26/pub/33040/touchstone/AssessmentQPHTMLMode1//33040O261/33040O261S20D1366/17780622786…

                                                                                                                                                                                                                                              1/42

Participants Id 
Participant Name 
Test Center Name Gandhi Institute For Technology
Test Date 22/04/2026
Test Time 12:30 PM - 2:00 PM

Subject

Section : Mathematics

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


https://adda247.go.link/2CeOD


Q.1 A, 30% କ୍ଷତିରେ B କୁ ଏକ ସ୍ମାର୍ଟଫୋନ୍ ବିକ୍ରି କରେ ଏବଂ B, ଏହି ସ୍ମାର୍ଟଫୋନ୍ 25% ଲାଭରେ C କୁ ବିକ୍ରି କରେ ।
ଯଦି C ଏହି ସ୍ମାର୍ଟଫୋନକୁ ₹67,158 ରେ କିଣିଥାଏ, ତେବେ A ପାଇଁ  ସ୍ମାର୍ଟଫୋନର କ୍ରୟ ମୂଲ୍ୟ (₹ ରେ) କେତେ
ଥିଲା?

Ans A. 76,752

B. 76,755

C. 76,750

D. 76,747

Question Type : MCQ
Question ID : 441009895014
Option 1 ID : 4410093534126
Option 2 ID : 4410093534129
Option 3 ID : 4410093534127
Option 4 ID : 4410093534128

Status : Answered
Chosen Option : B

Q.2 ବାର୍ଷିକ 4% ସରଳ ସୁଧ ହାରରେ, 2 ବର୍ଷରେ ₹240 ସୁଧ ମିଳୁଥିଲେ, ମୂଳଧନର ପରିମାଣ (₹ ରେ) କେତେ?

Ans A. 4,000

B. 6,000

C. 1,500

D. 3,000

Question Type : MCQ
Question ID : 441009898075
Option 1 ID : 4410093546373
Option 2 ID : 4410093546372
Option 3 ID : 4410093546371
Option 4 ID : 4410093546370

Status : Answered
Chosen Option : A

Q.3 ଦୁଇଟି ଟ୍ରେନ ସମାନ୍ତର ଧାରଣାରେ ପରସ୍ପରର ବିପରୀତ ଦିଗରେ ଗତି କରୁ ଛନ୍ତି । ଟ୍ରେନ A ର ଦୈର୍ଘ୍ୟ 120 m ଏବଂ
ଏହାର ବେଗ 36 km/h ଅଟେ । ଟ୍ରେନ B ର ଦୈର୍ଘ୍ୟ 80 m ଅଟେ । ସେଗୁଡିକ ପରସ୍ପରକୁ 6 ସେକେଣ୍ଡରେ ଅତିକ୍ରମ
କରନ୍ତି । ଟ୍ରେନ B ର ବେଗ km/h ରେ ନିର୍ଣ୍ଣୟ କର ।

Ans A. 54 km/h

B. 90 km/h

C. 72 km/h

D. 84 km/h

Question Type : MCQ
Question ID : 4410091419307
Option 1 ID : 4410095606151
Option 2 ID : 4410095606154
Option 3 ID : 4410095606152
Option 4 ID : 4410095606153

Status : Answered
Chosen Option : A
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Q.4 ନିର୍ଦ୍ଦିଷ୍ଟ ସରଳ ସୁଧ ହାରରେ 2 ବର୍ଷରେ ₹610 ମୂଳଧନର ସମୂଳସୁଧ ₹886 ହୁଏ । ଉକ୍ତ 2 ବର୍ଷ ପାଇଁ  ସୁଧର ପରିମାଣ
(₹ ରେ) ନିର୍ଣ୍ଣୟ କର ।

Ans A. 276

B. 291

C. 286

D. 271

Question Type : MCQ
Question ID : 441009853096
Option 1 ID : 4410093365356
Option 2 ID : 4410093365359
Option 3 ID : 4410093365357
Option 4 ID : 4410093365358

Status : Answered
Chosen Option : A

Q.5 ଜଣେ ବ୍ୟବସାୟୀ ₹800 ରେ ଏକ ଘଡ଼ି କିଣି ଏହାକୁ 10% ଲାଭରେ A କୁ ବିକ୍ରି କରନ୍ତି । A ଏହାକୁ 20% ଲାଭରେ B
କୁ ବିକ୍ରି କରନ୍ତି । B ଦେଇଥିବା ଅର୍ଥରାଶି ନିର୍ଣ୍ଣୟ କର ।

Ans A. ₹1,056

B. ₹1,182

C. ₹1,146

D. ₹1,012

Question Type : MCQ
Question ID : 4410091450337
Option 1 ID : 4410095729866
Option 2 ID : 4410095729869
Option 3 ID : 4410095729867
Option 4 ID : 4410095729868

Status : Answered
Chosen Option : A

Q.6 ସଂଖ୍ୟା 1, 2, 3, x, y, 7, 11, 17 ଓ 21 ର ହାରାହାରି 9 ଅଟେ । ଯଦି x ଓ y ର ଗୁଣଫଳ 60 ହୁଏ, ତେବେ 3x +
4y ର ମୂଲ୍ୟ ନିରୂ ପଣ କର, ପ୍ରଦତ୍ତ y, x ଠାରୁ  କମ ଅଟେ ।

Ans A. 61

B. 56

C. 72

D. 74

Question Type : MCQ
Question ID : 441009900285
Option 1 ID : 4410093555212
Option 2 ID : 4410093555211
Option 3 ID : 4410093555210
Option 4 ID : 4410093555213

Status : Answered
Chosen Option : B
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Q.7 ସମାନ କ୍ଷମତା ବିଶିଷ୍ଟ ବାରଟି ଟ୍ୟାପ ଏକ ଟାଙ୍କିକୁ 25 ମିନିଟରେ ପୂର୍ଣ୍ଣ କରିପାରନ୍ତି । ସେହି ସମାନ ଟାଙ୍କିକୁ 20
ମିନିଟରେ ପୂର୍ଣ୍ଣ କରିବା ପାଇଁ  ଏହିପରି କେତୋଟି ଟ୍ୟାପ ଆବଶ୍ୟକ?

Ans A. 15

B. 16

C. 12

D. 14

Question Type : MCQ
Question ID : 441009899918
Option 1 ID : 4410093553744
Option 2 ID : 4410093553745
Option 3 ID : 4410093553742
Option 4 ID : 4410093553743

Status : Answered
Chosen Option : A

Q.8 ତିନୋଟି ପାଇପ X, Y ଓ Z ଦ୍ୱାରା ଗୋଟିଏ ଟାଙ୍କିକୁ 10 ଘଣ୍ଟାରେ ପୂର୍ଣ୍ଣ କରାଯାଇପାରିବ । ପାଇପ Z ପାଇପ Y ଠାରୁ
ଦୁଇଗୁଣ ଦ୍ରୁତ ଏବଂ ପାଇପ Y ପାଇପ X ଠାରୁ  ଦୁଇଗୁଣ ଦ୍ରୁତ ଅଟେ । ଏକାକୀ ପାଇପ X ଦ୍ୱାରା ଟାଙ୍କିଟି ପୂର୍ଣ୍ଣ ହେବା
ପାଇଁ  କେତେ ସମୟ ଲାଗିବ?

Ans A. 60 ଘଣ୍ଟା

B. 50 ଘଣ୍ଟା

C. 80 ଘଣ୍ଟା

D. 70 ଘଣ୍ଟା

Question Type : MCQ
Question ID : 441009198476
Option 1 ID : 441009781470
Option 2 ID : 441009781469
Option 3 ID : 441009781472
Option 4 ID : 441009781471

Status : Answered
Chosen Option : A

Q.9 ସମୀକରଣ ପ୍ରଣାଳୀ 2x – 4y +3z = 4, x + 2y + 4z = 6 ଏବଂ 3x – 2y +2z = 0 ର ପୂର୍ଣ୍ଣସଂଖ୍ୟା ସମାଧାନର
ସଂଖ୍ୟା _________ ଅଟେ ।

Ans A. 2

B. 3

C. 1

D. 0

Question Type : MCQ
Question ID : 441009218011
Option 1 ID : 441009855973
Option 2 ID : 441009855974
Option 3 ID : 441009855972
Option 4 ID : 441009855971

Status : Answered
Chosen Option : D
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Q.10 ଜଣେ ବ୍ୟକ୍ତି  ତାଙ୍କ ହଷ୍ଟେଲରୁ  କଲେଜକୁ ସାଇକେଲରେ 30 km/h ବେଗରେ ଯାଆନ୍ତି ଏବଂ 4.5 ମିନିଟ ବିଳମ୍ବରେ
ପହଞ୍ଚନ୍ତି । ଯଦି ସେ 40 km/h ବେଗରେ ସାଇକେଲ ଚାଳନା କରନ୍ତି, ତେବେ ସେ 4.5 ମିନିଟ ପୂର୍ବରୁ  ପହଞ୍ଚନ୍ତି ।
ହଷ୍ଟେଲ ଓ କଲେଜ ମଧ୍ୟରେ ଦୂରତା (km ରେ) କେତେ?

Ans A. 18

B. 12

C. 16

D. 14

Question Type : MCQ
Question ID : 441009201343
Option 1 ID : 441009792525
Option 2 ID : 441009792522
Option 3 ID : 441009792524
Option 4 ID : 441009792523

Status : Answered
Chosen Option : B

Q.11 ନୀତିନଙ୍କ ପାଖରେ ₹1281 ଅଛି । ସେ ଏହାକୁ ତାଙ୍କ ପୁଅ ପ୍ରବିଣ ଏବଂ ରିଷିଙ୍କ ମଧ୍ୟରେ ବାଣ୍ଟି ଦେଲେ ଏବଂ
ସେମାନଙ୍କୁ ବାର୍ଷିକ ଭାବରେ ଚକ୍ରବୃଦ୍ଧି ହେଉଥିବା 10% ସୁଧ ହାରରେ ନିବେଶ କରିବାକୁ କହିଲେ । ଦେଖାଗଲା ଯେ
ପ୍ରବିଣ ଏବଂ ରିଷି ଯଥାକ୍ରମେ 13 ଏବଂ 14 ବର୍ଷ ପରେ ସମାନ ପରିମାଣ ପାଇଲେ । ନୀତିନ ରିଷିଙ୍କୁ କେତେ (₹ ରେ)
ଦେଇଥିଲେ?

Ans A. 771

B. 610

C. 671

D. 460

Question Type : MCQ
Question ID : 441009573669
Option 1 ID : 4410092249799
Option 2 ID : 4410092249796
Option 3 ID : 4410092249797
Option 4 ID : 4410092249798

Status : Answered
Chosen Option : B

Q.12 ଦୁଇଟି ବର୍ଗାକାର ପାର୍କର ବାହୁ 4 m ଏବଂ 16 m ଅଟେ । ଏକ ତୃତୀୟ ବର୍ଗାକାର ପାର୍କ ଏପରି ଭାବରେ ଡିଜାଇନ
କରାଯାଇଛି ଯେ ଏହାର ବାହୁ ପ୍ରଦତ୍ତ ଦୁଇଟି ପାର୍କର ବାହୁଙ୍କ ମଧ୍ୟରେ ମଧ୍ୟ ସମାନୁପାତୀ ହେବ । ତୃତୀୟ ବର୍ଗାକାର
ପାର୍କର କ୍ଷେତ୍ରଫଳ କେତେ ?

Ans A. 60 m²

B. 96 m²

C. 48 m²

D. 64 m²

Question Type : MCQ
Question ID : 4410091635517
Option 1 ID : 4410096460089
Option 2 ID : 4410096460090
Option 3 ID : 4410096460088
Option 4 ID : 4410096460087

Status : Answered
Chosen Option : A
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Q.13 X ରୁ  X ର 10% କୁ ବିୟୋଗ କଲେ ବିୟୋଗଫଳ, X କୁ କାହା ସହ ଗୁଣନ କରିବା ସଙ୍ଗେ ସମାନ?

Ans A. 0.9

B. 0.01

C. 0.1

D. 0.5

Question Type : MCQ
Question ID : 441009857524
Option 1 ID : 4410093383068
Option 2 ID : 4410093383071
Option 3 ID : 4410093383069
Option 4 ID : 4410093383070

Status : Answered
Chosen Option : C

Q.14 ତିନି ଜଣ ପ୍ରାର୍ଥୀ A, B ଏବଂ C ଙ୍କ ଏକ ନିର୍ବାଚନରେ ପ୍ରାର୍ଥୀ B ମୋଟ ଭୋଟର 35% ଭୋଟ ପାଇଥାନ୍ତି । ପ୍ରାର୍ଥୀ A
ପ୍ରାର୍ଥୀ B ଠାରୁ  1,600 ଅଧିକ ଭୋଟ ଏବଂ ପ୍ରାର୍ଥୀ C ଠାରୁ  4,870 ଅଧିକ ଭୋଟ ପାଆନ୍ତି । ମତଦାନ ହୋଇଥିବା
ମୋଟ ବୈଧ ଭୋଟ ସଂଖ୍ୟା ନିର୍ଣ୍ଣୟ କର ।

Ans A. 1,20,000

B. 33,400

C. 97,400

D. 87,400

Question Type : MCQ
Question ID : 441009894065
Option 1 ID : 4410093530330
Option 2 ID : 4410093530333
Option 3 ID : 4410093530331
Option 4 ID : 4410093530332

Status : Answered
Chosen Option : B

Q.15 ଯଦି  ଏବଂ  ହୁଏ, ତେବେ
 ର ମୂଲ୍ୟ କେତେ ଅଟେ?

Ans A. 

B. 0

C. 

D. 1

Question Type : MCQ
Question ID : 441009602599
Option 1 ID : 4410092365513
Option 2 ID : 4410092365515
Option 3 ID : 4410092365514
Option 4 ID : 4410092365516

Status : Not Answered
Chosen Option : --
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Q.16 12 ଦ୍ଵାରା ଏକ ଛଅ ଅଙ୍କ ବିଶିଷ୍ଟ ସଂଖ୍ୟା 8B89A6 ସଂପୂର୍ଣ୍ଣ ରୂ ପେ ବିଭାଜ୍ୟ ହୁଏ, ଯେଉଁ ଠାରେ A ≠ B ଅଟେ । (A +
B) ର ସର୍ବନିମ୍ନ ସମ୍ଭାବ୍ୟ ମୂଲ୍ୟ କେତେ ଅଟେ?

Ans A. 1

B. 2

C. 5

D. 3

Question Type : MCQ
Question ID : 441009560327
Option 1 ID : 4410092196577
Option 2 ID : 4410092196575
Option 3 ID : 4410092196576
Option 4 ID : 4410092196578

Status : Answered
Chosen Option : B

Q.17 A, B ଏବଂ C ଯଥାକ୍ରମେ ₹1,10,016, ₹1,23,768 ଏବଂ ₹1,65,024 ନିବେଶ କରି ଏକ ପାର୍ଟନରସିପ ଆରମ୍ଭ
କରିଥିଲେ । ଯଦି ସେମାନେ ବାର୍ଷିକ ₹1,54,657 ଲାଭ ଅର୍ଜନ କରନ୍ତି, ତେବେ ଲାଭରେ B ର ଭାଗ (₹ ରେ) କେତେ
ଅଟେ?

Ans A. 54,475

B. 49,560

C. 47,997

D. 51,235

Question Type : MCQ
Question ID : 441009896516
Option 1 ID : 4410093540137
Option 2 ID : 4410093540135
Option 3 ID : 4410093540134
Option 4 ID : 4410093540136

Status : Answered
Chosen Option : A

Q.18 2000 ରୁ  କମ କେତୋଟି ସଂଖ୍ୟା ଉଭୟ 10 ଓ 17 ର ଗୁଣିତକ ଅଟେ?

Ans A. 11

B. 13

C. 9

D. 7

Question Type : MCQ
Question ID : 441009273048
Option 1 ID : 4410091060739
Option 2 ID : 4410091060742
Option 3 ID : 4410091060740
Option 4 ID : 4410091060741

Status : Answered
Chosen Option : A
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Q.19 ଯଦି  ହୁଏ, ତେବେ  ଏବଂ  ର ମଧ୍ୟ ସମାନୁପାତୀ ନିର୍ଣ୍ଣୟ କର ।

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 4410091441260
Option 1 ID : 4410095693695
Option 2 ID : 4410095693697
Option 3 ID : 4410095693696
Option 4 ID : 4410095693698

Status : Not Answered
Chosen Option : --

Q.20 ଏକ ବୃତ୍ତର ଚାପର ଦୈର୍ଘ୍ୟ 28 cm ଅଟେ ଏବଂ ଏହା କେନ୍ଦ୍ରରେ 72° କୋଣ ସୃଷ୍ଟି  କରେ । ବୃତ୍ତର ପରିଧି (cm ରେ)
କେତେ ଅଟେ ?

Ans A. 109

B. 98

C. 112

D. 140

Question Type : MCQ
Question ID : 441009592171
Option 1 ID : 4410092323802
Option 2 ID : 4410092323801
Option 3 ID : 4410092323803
Option 4 ID : 4410092323804

Status : Answered
Chosen Option : B

Section : General Studies

5/16/26, 11:35 AM cdn3.digialm.com//per/g26/pub/33040/touchstone/AssessmentQPHTMLMode1//33040O261/33040O261S20D1366/17780622786…

https://cdn3.digialm.com//per/g26/pub/33040/touchstone/AssessmentQPHTMLMode1//33040O261/33040O261S20D1366/17780622786365662/169… 8/42

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Q.21 ନିମ୍ନଲିଖିତ ମଧ୍ୟରୁ  କେଉଁ  ଜଳବାୟୁ  ନିୟନ୍ତ୍ରକ, ଅକ୍ଷାଂଶ ସହ ପରିବର୍ତ୍ତନ ହୁଏ ଏବଂ ବର୍ଷସାରା ପୃଥିବୀର ତାପମାତ୍ରା
ପବୃତ୍ତି (temperature patterns) କୁ ପ୍ରଭାବିତ କରେ?

Ans A. ମହାସାଗରୀୟ ସ୍ରୋତ

B. ସୂର୍ଯ୍ୟକିରଣର ତୀବ୍ରତା

C. ଭୂ ମିରୁ ପ

D. ଉଦ୍ଭିଦାଞ୍ଚଳ

Question Type : MCQ
Question ID : 4410091026935
Option 1 ID : 4410094059313
Option 2 ID : 4410094059314
Option 3 ID : 4410094059315
Option 4 ID : 4410094059316

Status : Answered
Chosen Option : A

Q.22 ନିମ୍ନଲିଖିତମାନଙ୍କ ମଧ୍ୟରୁ  କିଏ ହିନ୍ଦୁସ୍ତାନ ଗଦର ପାର୍ଟି (Hindustan Ghadar Party) ର ପ୍ରତିଷ୍ଠାତା ସଭାପତି
(founding president) ଥିଲେ?

Ans A. ଲାଲା ଲଜପତ ରାୟ

B. ବାବା ରାମ ସିଂହ

C. ବାବା ସୋହନ ସିଂହ ଭକନା (Baba Sohan Singh Bhakna)

D. ଲାଲା ହର ଦୟାଲ (Lala Har Dayal)

Question Type : MCQ
Question ID : 441009944171
Option 1 ID : 4410093730269
Option 2 ID : 4410093730271
Option 3 ID : 4410093730270
Option 4 ID : 4410093730268

Status : Answered
Chosen Option : A

Q.23 ଭାରତୀୟ ଚଳଚ୍ଚିତ୍ର ସଂଗୀତରେ ଅବଦାନ ପାଇଁ  କେଉଁ  ପ୍ରସିଦ୍ଧ ଗାୟକଙ୍କୁ ପଦ୍ମଭୂ ଷଣ 2026 ପୁରସ୍କାର ପ୍ରଦାନ
କରାଯାଇଛି?

Ans A. ଅଲକା ୟାଗନିକ

B. ଶ୍ରେୟା ଘୋଷାଲ

C. ଅରିଜିତ ସିଂ

D. ସୋନୁ ନିଗମ

Question Type : MCQ
Question ID : 4410091834139
Option 1 ID : 4410097230436
Option 2 ID : 4410097230438
Option 3 ID : 4410097230437
Option 4 ID : 4410097230439

Status : Answered
Chosen Option : C
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Q.24 4 kg ବସ୍ତୁତ୍ବ ବିଶିଷ୍ଟ ଏକ ବସ୍ତୁ  ଉପରେ 2 ସେକେଣ୍ଡ ପାଇଁ  ନିର୍ଦ୍ଧିଷ୍ଟ ବଳ ପ୍ରୟୋଗ କରାଯାଏ । ଏହା ବସ୍ତୁର ପରିବେଗକୁ
4 m/s ରୁ  14 m/s କୁ ବୃଦ୍ଧି କରେ । ପ୍ରୟୋଗ ହୋଇଥିବା ବଳର ପରିମାଣ କେତେ?

Ans A. 80 N

B. 20 N

C. 40 N

D. 10 N

Question Type : MCQ
Question ID : 4410091445097
Option 1 ID : 4410095708980
Option 2 ID : 4410095708978
Option 3 ID : 4410095708979
Option 4 ID : 4410095708977

Status : Answered
Chosen Option : B

Q.25 2026 ୱିଣ୍ଟର ଅଲିମ୍ପିକ୍ସରେ କେଉଁ  ଦଳ ପୁରୁ ଷ ଆଇସ ହକି ସ୍ୱର୍ଣ୍ଣ ପଦକ ଜିତିଥିଲା?

Ans A. କାନାଡା

B. ଇଟାଲୀ

C. ରୁ ଷିଆ

D. ଯୁକ୍ତରାଷ୍ଟ୍ର ଆମେରିକା

Question Type : MCQ
Question ID : 4410091861975
Option 1 ID : 4410097338142
Option 2 ID : 4410097338145
Option 3 ID : 4410097338144
Option 4 ID : 4410097338143

Status : Answered
Chosen Option : A

Q.26 କାଙ୍ଗର ଉପତ୍ୟକାର ଦଣ୍ଡକ ଗୁମ୍ଫା (Dandak Caves) ଏବଂ ଚୂନପଥର ଗଠନ (limestone formations) କେଉଁ
ରାଜ୍ୟରେ ଦେଖିବାକୁ ମିଳେ?

Ans A. ଓଡ଼ିଶା

B. ଆନ୍ଧ୍ରପ୍ରଦେଶ

C. ବିହାର

D. ଛତିଶଗଡ଼

Question Type : MCQ
Question ID : 441009978489
Option 1 ID : 4410093866598
Option 2 ID : 4410093866597
Option 3 ID : 4410093866600
Option 4 ID : 4410093866599

Status : Answered
Chosen Option : B
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Q.27 ଓଡ଼ିଶାର କେଉଁ  ଜିଲ୍ଲାରେ ଲୋକପ୍ରିୟ ଲୋକନୃତ୍ୟ ଦଣ୍ଡ ନାଟ ମୁଖ୍ୟତଃ ପରିବେଷଣ କରାଯାଏ?

Ans A. ପୁରୀ

B. ଗଞ୍ଜାମ

C. କଟକ

D. ଖୋର୍ଦ୍ଧା

Question Type : MCQ
Question ID : 4410091424352
Option 1 ID : 4410095626235
Option 2 ID : 4410095626237
Option 3 ID : 4410095626236
Option 4 ID : 4410095626238

Status : Answered
Chosen Option : B

Q.28 ସ୍ଥିରାନୁପାତ ନିୟମ କ'ଣ ଦର୍ଶାଏ?

Ans A. ରାସାୟନିକ ପ୍ରତିକ୍ରିୟାରେ ଗ୍ୟାସୀୟ ପଦାର୍ଥର ଆୟତନ ସର୍ବଦା ସମାନ ରହେ ।

B. ବିଭିନ୍ନ ଯୌଗିକରେ ଏକ ମୌଳିକର ବସ୍ତୁତ୍ୱ ଭିନ୍ନ ହୋଇପାରେ ।

C. ଉତ୍ସ ଉପରେ ନିର୍ଭର କରି ମୌଳିକଗୁଡ଼ିକର ଗୁଣଧର୍ମ ପରିବର୍ତ୍ତନ ହୁଏ ।

D. ଏକ ରାସାୟନିକ ଯୌଗିକରେ ମୌଳିକଗୁଡ଼ିକ ସର୍ବଦା ବସ୍ତୁତ୍ୱ ଅନୁସାରେ ନିର୍ଦ୍ଦିଷ୍ଟ ଅନୁପାତରେ ଉପସ୍ଥିତ ଥାଆନ୍ତି ।

Question Type : MCQ
Question ID : 4410091432145
Option 1 ID : 4410095656912
Option 2 ID : 4410095656911
Option 3 ID : 4410095656913
Option 4 ID : 4410095656910

Status : Answered
Chosen Option : B

Q.29 ନିମ୍ନଲିଖିତଙ୍କ ମଧ୍ୟରୁ  କିଏ 19 ଶତାବ୍ଦୀର ଜଣେ ପ୍ରସିଦ୍ଧ ଓଡ଼ିଆ କବି ଥିଲେ, ଯିଏ "ସ୍ୱଭାବ କବି" ଭାବରେ ଜଣାଶୁଣା?

Ans A. ମଧୁସୂଦନ ରାଓ

B. ଫକିର ମୋହନ ସେନାପତି

C. ଗଙ୍ଗାଧର ମେହେର

D. ରାଧାନାଥ ରାୟ

Question Type : MCQ
Question ID : 441009563570
Option 1 ID : 4410092209403
Option 2 ID : 4410092209401
Option 3 ID : 4410092209402
Option 4 ID : 4410092209400

Status : Answered
Chosen Option : B
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Q.30 ନିମ୍ନଲିଖିତ କେଉଁ  ସଙ୍ଗୀତଜ୍ଞ-ବାଦ୍ୟଯନ୍ତ୍ର ଯୋଡି ସଠିକ ଭାବରେ ମେଳ ଖାଉଛି?

Ans A. ବିସମିଲ୍ଲା ଖାନ – ସନ୍ତୂ ର

B. ଅମଜଦ ଅଲ୍ଲୀ ଖାନ – ଭାୟୋଲିନ

C. ଜାକିର ହୁସେନ – ବଂଶୀ

D. ରବି ଶଙ୍କର – ସିତାର

Question Type : MCQ
Question ID : 441009608385
Option 1 ID : 4410092388659
Option 2 ID : 4410092388660
Option 3 ID : 4410092388658
Option 4 ID : 4410092388657

Status : Answered
Chosen Option : D

Q.31 2026 ଧଉଳି-କଳିଙ୍ଗ ମହୋତ୍ସବ କେଉଁ ଠାରେ ଆୟୋଜିତ ହୋଇଥିଲା?

Ans A. ରବୀନ୍ଦ୍ର ମଣ୍ଡପ, ଭୁ ବନେଶ୍ୱର

B. ବାରବାଟୀ ଷ୍ଟାଡିୟମ, କଟକ

C. କୋଣାର୍କ ନାଟ୍ୟ ମଣ୍ଡପ, କୋଣାର୍କ

D. ଶାନ୍ତି ବିହାର, ଧଉଳିର ପାଦଦେଶ

Question Type : MCQ
Question ID : 4410091863088
Option 1 ID : 4410097342550
Option 2 ID : 4410097342552
Option 3 ID : 4410097342553
Option 4 ID : 4410097342551

Status : Answered
Chosen Option : D

Q.32 ଗାନ୍ଧୀଜୀଙ୍କ ନେତୃତ୍ୱ ଯାତ୍ରା ଉପରେ ଖେଡା ସତ୍ୟାଗ୍ରହର ବ୍ୟାପକ ପ୍ରଭାବ କ’ଣ ଥିଲା?

Ans A. ଏହା ତାଙ୍କର ଏବଂ ସ୍ଥାନୀୟ ନେତାମାନଙ୍କ ମଧ୍ୟରେ ଦ୍ୱନ୍ଦ୍ୱ ସୃଷ୍ଟି  କରିଥି ଲା

B. ଏହା ତାଙ୍କୁ କୃଷକ ରାଜନୀତିରୁ  ଅପସରି ଯିବାକୁ ବାଧ୍ୟ କରିଥି ଲା

C. ଏହା ଗୁଜରାଟରେ ତାଙ୍କର ସମ୍ମାନକୁ କ୍ଷୁର୍ଣ୍ଣ କରିଥି ଲା

D. ଏହା ତାଙ୍କୁ ଗ୍ରାମୀଣ ଗୁଜରାଟରେ ତାଙ୍କର ଆଧାର ବିସ୍ତାର କରିବାରେ ସାହାଯ୍ୟ କରିଥି ଲା

Question Type : MCQ
Question ID : 4410091068648
Option 1 ID : 4410094220094
Option 2 ID : 4410094220095
Option 3 ID : 4410094220092
Option 4 ID : 4410094220093

Status : Answered
Chosen Option : A
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Q.33 ନିମ୍ନଲିଖିତ କେଉଁ  ଗ୍ୟାସ ଓଜୋନ ସ୍ତର କ୍ଷୟ ପାଇଁ  ମୁଖ୍ୟତଃ ଦାୟୀ ଅଟେ?

Ans A. କ୍ଲୋରୋଫ୍ଲୋ ରୋକାର୍ବନ (CFCs)

B. ନାଇଟ୍ରୋଜେନ (N2)

C. ଅକ୍ସିଜେନ (O2)

D. କାର୍ବନ ଡାଇଅକ୍ସାଇଡ (CO2)

Question Type : MCQ
Question ID : 4410091437979
Option 1 ID : 4410095680619
Option 2 ID : 4410095680620
Option 3 ID : 4410095680618
Option 4 ID : 4410095680617

Status : Answered
Chosen Option : A

Q.34 ନିମ୍ନଲିଖିତ ମଧ୍ୟରୁ  କେଉଁ  ସାହିତ୍ୟ କୃତି, ଆବୁଲ-ଫଜଲ ଙ୍କ ଦ୍ୱାରା ଲିଖିତ, ଯାହା ଆକବରଙ୍କ ଶାସନକାଳକୁ ବର୍ଣ୍ଣନା
କରେ?

Ans A. ତୁ ଜୁକ-ଇ-ଆକବରୀ (Tuzuk-i-Akbari)

B. ଆକବରନାମା (Akbarnama)

C. ଅଲ୍ଲାହୁ ଆକବର (Allahu Akbar)

D. ଆକବର: ଦି ଗ୍ରେଟ ମୋଗଲ (Akbar: The Great Mughal)

Question Type : MCQ
Question ID : 4410091847990
Option 1 ID : 4410097284247
Option 2 ID : 4410097284244
Option 3 ID : 4410097284245
Option 4 ID : 4410097284246

Status : Answered
Chosen Option : B

Q.35 ଜିଲ୍ଲା ସ୍ତରରେ ଶିଶୁ କଲ୍ୟାଣ ସମିତି ଏବଂ ଜୁଭେନାଇଲ ଜଷ୍ଟିସ ବୋର୍ଡ ପାଇଁ  ମିଶନ ବାତ୍ସଲ୍ୟ ପୋର୍ଟାଲ କେଉଁ  କାର୍ଯ୍ୟ
ସମ୍ପାଦନ କରେ?

Ans A. ଚାଇଲ୍ଡ କେୟାର ପ୍ଳାନ ଏବଂ କେସ ହିଷ୍ଟ୍ରି ର ଡିଜିଟାଲ ରକ୍ଷଣାବେକ୍ଷଣକୁ ସହଜ କରେ

B. ସମସ୍ତ ପୋଷ୍ୟ ସନ୍ତାନ ଆବେଦନପତ୍ର (adoption application) ସିଧାସଳଖ ଅନୁମୋଦନ କରେ

C. ପିଲାମାନଙ୍କୁ ମେଡିକାଲ ଚିକିତ୍ସା ପ୍ରଦାନ କରେ

D. ଗୋଷ୍ଠୀ  ସଚେତନତା ଅଭିଯାନ ପରିଚାଳନା କରେ

Question Type : MCQ
Question ID : 4410091835249
Option 1 ID : 4410097234788
Option 2 ID : 4410097234789
Option 3 ID : 4410097234791
Option 4 ID : 4410097234790

Status : Answered
Chosen Option : B
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Q.36 ଭାରତର ସୀମିତ ଭିତ୍ତିଭୂ ମି ବିକାଶ ଥିବା ଅଞ୍ଚଳରେ ନିମ୍ନଲିଖିତ କେଉଁ  ଅଣ-ବ୍ୟବସାୟିକ ଶକ୍ତି  ଉତ୍ସ ସାଧାରଣତଃ
ବ୍ୟବହୃତ ହୋଇଥାଏ?

Ans A. କୋଇଲା

B. ପେଟ୍ରୋଲିୟମ

C. ଜାଳେଣୀ କାଠ

D. ବିଦ୍ୟୁତ ଶକ୍ତି

Question Type : MCQ
Question ID : 441009869121
Option 1 ID : 4410093429516
Option 2 ID : 4410093429518
Option 3 ID : 4410093429517
Option 4 ID : 4410093429515

Status : Answered
Chosen Option : D

Q.37 ଭାରତୀୟ ସମ୍ବି ଧାନରେ କେତୋଟି ମୌଳିକ କର୍ତ୍ତବ୍ୟ ରହିଛି?

Ans A. 6

B. 12

C. 9

D. 11

Question Type : MCQ
Question ID : 441009870452
Option 1 ID : 4410093434761
Option 2 ID : 4410093434763
Option 3 ID : 4410093434762
Option 4 ID : 4410093434760

Status : Answered
Chosen Option : B

Q.38 6 ଷ୍ଠ ଖେଲୋ ଇଣ୍ଡିଆ ୱିଣ୍ଟର ଗେମ୍ସ 2026 (6th Khelo India Winter Games 2026) ପ୍ରାଥମିକ ଭାବେ କେଉଁ
ସ୍ଥାନରେ ଅନୁଷ୍ଠି ତ ହୋଇଥିଲା?

Ans A. ଔଲୀ, ଉତ୍ତରାଖଣ୍ଡ

B. ଲେହ, ଲଦାଖ

C. ଶିମଲା, ହିମାଚଳ ପ୍ରଦେଶ

D. ଶିଲଂ, ମେଘାଳୟ

Question Type : MCQ
Question ID : 4410091834378
Option 1 ID : 4410097231390
Option 2 ID : 4410097231388
Option 3 ID : 4410097231389
Option 4 ID : 4410097231391

Status : Answered
Chosen Option : A
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Q.39 2011 ଜନଗଣନା ଅନୁଯାୟୀ, 2001-2011 ଅବଧିରେ ଭାରତରେ ହିନ୍ଦୁ ଜନସଂଖ୍ୟାର ଅଭିବୃଦ୍ଧି ହାର କେତେ ଥିଲା ?

Ans A. 16.8 %

B. 15.4 %

C. 24.6 %

D. 15.5 %

Question Type : MCQ
Question ID : 441009866839
Option 1 ID : 4410093420389
Option 2 ID : 4410093420388
Option 3 ID : 4410093420391
Option 4 ID : 4410093420390

Status : Answered
Chosen Option : A

Q.40 ଓଡ଼ିଶା ସରକାରଙ୍କ ଆଧିକାରିକ ସୂତ୍ର ଅନୁଯାୟୀ, ମୃତ୍ତିକା, ଜଳବାୟୁ  ଏବଂ ଆନୁଷଙ୍ଗି କ ବୈଶିଷ୍ଟ୍ୟକୁ ଆଧାର କରି
ରାଜ୍ୟକୁ କେତୋଟି କୃଷି-ଜଳବାୟୁ  ଜୋନ୍ (Agro-climatic zones) ରେ ବିଭକ୍ତ କରାଯାଇଛି?

Ans A. 12

B. 10

C. 9

D. 8

Question Type : MCQ
Question ID : 4410091424481
Option 1 ID : 4410095626778
Option 2 ID : 4410095626777
Option 3 ID : 4410095626776
Option 4 ID : 4410095626775

Status : Answered
Chosen Option : A

Q.41 ଜୈବ ଅବନମିତ ଅକ୍ଷମ ବର୍ଜ୍ୟବସ୍ତୁର ନିଷ୍କାସନ ସମ୍ବନ୍ଧୀୟ ସଠିକ ବିକଳ୍ପ ଚୟନ କର ।
ବିବୃତି I: ଜୈବ ଅବନମିତ ଅକ୍ଷମ ବର୍ଜ୍ୟବସ୍ତୁକୁ ଜାଳିବା ଏହାର ନିଷ୍କାସନ ପାଇଁ  ଏକ ସହଜ ଉପାୟ ।
ବିବୃତି II: ପ୍ଲାଷ୍ଟିକ ଜଳାଇବା ଦ୍ୱାରା କ୍ଷତିକାରକ ଗ୍ୟାସ ନିର୍ଗତ ହୋଇଥାଏ, ଯାହା ବାୟୁ  ପ୍ରଦୂଷଣ କରେ ।

Ans A. ଉଭୟ ବିବୃତି ସତ୍ୟ ଅଟେ କିନ୍ତୁ ବିବୃତି II ସଠିକ ବ୍ୟାଖ୍ୟା ନୁହେଁ

B. ବିବୃତି I ସତ୍ୟ ଅଟେ, ବିବୃତି II ମିଥ୍ୟା ଅଟେ

C. ଉଭୟ ବିବୃତି ସତ୍ୟ ଅଟେ ଏବଂ ବିବୃତି II, ବିବୃତି I ର ସଠିକ ବ୍ୟାଖ୍ୟା ଅଟେ

D. ବିବୃତି I ମିଥ୍ୟା ଅଟେ, ବିବୃତି II ସତ୍ୟ ଅଟେ

Question Type : MCQ
Question ID : 4410091452432
Option 1 ID : 4410095738121
Option 2 ID : 4410095738122
Option 3 ID : 4410095738120
Option 4 ID : 4410095738123

Status : Not Answered
Chosen Option : --
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Q.42 ଭାରତୀୟ ସମ୍ବି ଧାନର ଧାରା 18 ଅନୁଯାୟୀ ରାଷ୍ଟ୍ର ନିମ୍ନଲିଖିତ କେଉଁ  କାର୍ଯ୍ୟ କରିବା ନିଷେଧ ଅଟେ?

Ans A. ସାମରିକ ସମ୍ମାନ ପ୍ରଦାନ (Granting military distinctions)

B. ଅନୁସୂଚିତ ଜନଜାତିଙ୍କ ପାଇଁ  ସଂରକ୍ଷଣ ବ୍ୟବସ୍ଥା ପ୍ରଣୟନ (Creating reservations for Scheduled Tribes)

C. ରାୟ ବାହାଦୂର କିମ୍ବା  ଖାନ ବାହାଦୂର ଭଳି ଉପାଧି  ପ୍ରଦାନ

D. ଭାରତରତ୍ନ ଭଳି ଜାତୀୟ ସମ୍ମାନ ପ୍ରଦାନ

Question Type : MCQ
Question ID : 4410091443469
Option 1 ID : 4410095702390
Option 2 ID : 4410095702393
Option 3 ID : 4410095702392
Option 4 ID : 4410095702391

Status : Answered
Chosen Option : B

Q.43 ଓଡ଼ିଶାରେ ପର୍ଯ୍ୟଟନ ନିବେଶକୁ ପ୍ରୋତ୍ସାହିତ କରିବା ଏବଂ ପର୍ଯ୍ୟଟନ ଭିତ୍ତିଭୂ ମିକୁ ସୁଦୃଢ଼ ​​କରିବା ପାଇଁ  2026
ମସିହାରେ କେଉଁ  ନୀତିକୁ ଅଧିସୂଚିତ କରାଯାଇଥିଲା?

Ans A. ଓଡ଼ିଶା ପର୍ଯ୍ୟଟନ ପ୍ରୋତ୍ସାହନ ଏବଂ ବିକାଶ ନୀତି, 2026

B. ଓଡ଼ିଶା ପର୍ଯ୍ୟଟନ (ସଂଶୋଧନ) ନୀତି, 2026

C. ଓଡ଼ିଶା ପର୍ଯ୍ୟଟନ ପ୍ରୋତ୍ସାହନ ନୀତି, 2026

D. ଓଡ଼ିଶା ପର୍ଯ୍ୟଟନ ବିକାଶ ନୀତି, 2026

Question Type : MCQ
Question ID : 4410091864450
Option 1 ID : 4410097347146
Option 2 ID : 4410097347144
Option 3 ID : 4410097347147
Option 4 ID : 4410097347145

Status : Answered
Chosen Option : A

Q.44 ଭାରତୀୟ ସମ୍ବି ଧାନର କେଉଁ  ଧାରା ଶିଶୁମାନଙ୍କୁ ଶୋଷଣରୁ  ରକ୍ଷା କରିବା ପାଇଁ  ଆଇନ ପ୍ରଣୟନ କରିବାକୁ ରାଷ୍ଟ୍ରକୁ
ନିର୍ଦ୍ଦେଶ ପ୍ରଦାନ କରିଥାଏ?

Ans A. ଧାରା 40

B. ଧାରା 38

C. ଧାରା 39

D. ଧାରା 37

Question Type : MCQ
Question ID : 441009323318
Option 1 ID : 4410091259445
Option 2 ID : 4410091259443
Option 3 ID : 4410091259444
Option 4 ID : 4410091259442

Status : Answered
Chosen Option : B
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Q.45 ନିମ୍ନଲିଖିତ କେଉଁ  ରାଜ୍ୟ ସରକାର ଜାନୁଆରୀ 2025 ରେ ଓଡ଼ିଶାର ନୈନି ଠାରେ ଏକ ତାପଜ ବିଦ୍ୟୁତ କେନ୍ଦ୍ର ସ୍ଥାପନ
ପାଇଁ  ପ୍ରସ୍ତାବ ଦେଇଥିଲେ?

Ans A. ଆନ୍ଧ୍ରପ୍ରଦେଶ

B. ଝାଡ଼ଖଣ୍ଡ

C. ଛତିଶଗଡ଼

D. ତେଲେଙ୍ଗାନା

Question Type : MCQ
Question ID : 441009874931
Option 1 ID : 4410093453325
Option 2 ID : 4410093453328
Option 3 ID : 4410093453327
Option 4 ID : 4410093453326

Status : Answered
Chosen Option : B

Q.46 Identify the segment of the sentence that contains a grammatical error and rectify it by
choosing the correct option.
She has wrote several articles on climate change for the college magazine.

Ans A. She has written several articles on climate change for the college magazine.

B. She will wrote several articles on climate change for the college magazine.

C. She write several articles on climate change for the college magazine.

D. She had wrote several articles on climate change for the college magazine.

Question Type : MCQ
Question ID : 4410091828573
Option 1 ID : 4410097208460
Option 2 ID : 4410097208461
Option 3 ID : 4410097208458
Option 4 ID : 4410097208459

Status : Answered
Chosen Option : B

Section : English
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Q.47 Identify the best one-word substitution for the underlined phrase.

The rapid spread of a disease affecting a large number of people at the same time in
several areas caused panic.

Ans A. Epidemic

B. Endemic

C. Sporadic

D. Outbreak

Question Type : MCQ
Question ID : 4410091818512
Option 1 ID : 4410097169390
Option 2 ID : 4410097169391
Option 3 ID : 4410097169393
Option 4 ID : 4410097169392

Status : Answered
Chosen Option : C

Q.48 Choose the incorrect active voice form from the given options.

Ans A. The teacher explained the concept clearly to the students.

B. The manager approved the proposal after reviewing it carefully.

C. The homework was completed the students before the class.

D. She quickly completed the assignment before the deadline.

Question Type : MCQ
Question ID : 4410091825589
Option 1 ID : 4410097196657
Option 2 ID : 4410097196656
Option 3 ID : 4410097196658
Option 4 ID : 4410097196655

Status : Not Answered
Chosen Option : --

Q.49 Select the word that is closest in meaning to the opposite of the highlighted word in the
given sentence.

The detective's quick thinking foiled the criminal's plan.

Ans A. Assisted

B. Thwarted

C. Obstructed

D. Frustrated

Question Type : MCQ
Question ID : 4410091819310
Option 1 ID : 4410097172517
Option 2 ID : 4410097172514
Option 3 ID : 4410097172515
Option 4 ID : 4410097172516

Status : Answered
Chosen Option : A

5/16/26, 11:35 AM cdn3.digialm.com//per/g26/pub/33040/touchstone/AssessmentQPHTMLMode1//33040O261/33040O261S20D1366/17780622786…

https://cdn3.digialm.com//per/g26/pub/33040/touchstone/AssessmentQPHTMLMode1//33040O261/33040O261S20D1366/17780622786365662/16… 18/42

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Q.50 Choose the correct meaning of the given proverb.

Look before you leap.

Ans A. Think carefully and consider the consequences before taking action.

B. One should rely on luck rather than planning.

C. Leap at every opportunity without hesitation.

D. Acting quickly is always better than overthinking.

Question Type : MCQ
Question ID : 441009411428
Option 1 ID : 4410091611102
Option 2 ID : 4410091611104
Option 3 ID : 4410091611105
Option 4 ID : 4410091611103

Status : Answered
Chosen Option : B

Q.51 Which of the following is the correct indirect form of the given direct sentence?
The teacher said, "Students must submit their assignments by Friday."

Ans A. The teacher said students have to submit their assignments by Friday.

B. The teacher told that students must submit their assignments by Friday.

C. The teacher said that students should submit their assignments by Friday.

D. The teacher said that students must submit their assignments by Friday.

Question Type : MCQ
Question ID : 4410091820956
Option 1 ID : 4410097179071
Option 2 ID : 4410097179068
Option 3 ID : 4410097179070
Option 4 ID : 4410097179069

Status : Answered
Chosen Option : A

Q.52 Identify the part of the sentence that contains the error.
By the time the rescue team arrived at the site, the villagers already evacuated to safer
places near the hill station.

Ans A. the villagers already evacuated

B. By the time the rescue team

C. to safer places near the hill station

D. arrived at the site

Question Type : MCQ
Question ID : 4410091825452
Option 1 ID : 4410097196113
Option 2 ID : 4410097196111
Option 3 ID : 4410097196114
Option 4 ID : 4410097196112

Status : Answered
Chosen Option : A
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Q.53 Which of the following sentences is correctly formed in the past tense?

Ans A. Maria prepares dinner and goes to her mother’s house to help her with medicine.

B. Maria prepared dinner and go to her mother’s house to help her with medicine.

C. Maria prepare dinner and went to her mother’s house to help her with medicine.

D. Maria prepared dinner and went to her mother’s house to help her with medicine.

Question Type : MCQ
Question ID : 4410091833261
Option 1 ID : 4410097227033
Option 2 ID : 4410097227032
Option 3 ID : 4410097227035
Option 4 ID : 4410097227034

Status : Not Answered
Chosen Option : --

Q.54 Choose the word that best completes the sentence with the antonym of the highlighted
word.
Her scarce resources forced her to abandon the project, but with new funding,
resources became ______.

Ans A. measurable

B. organized

C. simulation

D. plentiful

Question Type : MCQ
Question ID : 4410091825815
Option 1 ID : 4410097197543
Option 2 ID : 4410097197544
Option 3 ID : 4410097197545
Option 4 ID : 4410097197542

Status : Answered
Chosen Option : B

Q.55 Which sentence from the given options correctly uses the future perfect tense?

Ans A. She will have been writing a letter by this time tomorrow.

B. She will be writing a letter.

C. She will have written the letter by tomorrow evening.

D. She will write a letter to her friend every day.

Question Type : MCQ
Question ID : 4410091827944
Option 1 ID : 4410097205978
Option 2 ID : 4410097205976
Option 3 ID : 4410097205977
Option 4 ID : 4410097205975

Status : Answered
Chosen Option : A
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Q.56 Identify the segment of the sentence that contains a grammatical error.

Today, I watched the playful, young puppy in the garden playing with a bounce ball and
making innocent gestures.

Ans A. playing with a bounce ball and

B. Today, I watched the playful,

C. young puppy in the garden

D. making innocent gestures

Question Type : MCQ
Question ID : 4410091820970
Option 1 ID : 4410097179122
Option 2 ID : 4410097179120
Option 3 ID : 4410097179121
Option 4 ID : 4410097179123

Status : Answered
Chosen Option : B

Q.57 Replace the underlined segment of the given sentence with the correct proverb.

He wasted his time by doing unnecessary things instead of focusing on his studies.

Ans A. made a mountain out of a molehill

B. spilled the beans

C. hit the nail on the head

D. let the grass grow under his feet

Question Type : MCQ
Question ID : 4410091649038
Option 1 ID : 4410096512367
Option 2 ID : 4410096512366
Option 3 ID : 4410096512365
Option 4 ID : 4410096512364

Status : Not Answered
Chosen Option : --

Q.58 Choose the correct one-word substitution for the highlighted segment.
She donated her wealth as she is a/an person who loves mankind.

Ans A. benefactor

B. philanthropist

C. idealist

D. humanitarian

Question Type : MCQ
Question ID : 4410091825679
Option 1 ID : 4410097197003
Option 2 ID : 4410097197004
Option 3 ID : 4410097197002
Option 4 ID : 4410097197005

Status : Answered
Chosen Option : A
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Q.59 Arrange P, Q, R, and S to form a meaningful sentence.
P. to solve complex problems efficiently
Q. critical thinking skills
R. enable individuals
S. in academic and professional contexts

Ans A. R Q P S

B. Q P R S

C. P Q R S

D. Q R P S

Question Type : MCQ
Question ID : 4410091824462
Option 1 ID : 4410097192432
Option 2 ID : 4410097192433
Option 3 ID : 4410097192434
Option 4 ID : 4410097192431

Status : Not Answered
Chosen Option : --

Q.60 Choose the correct one-word substitution for the highlighted segment.

He is respected as a/an person who draws maps.

Ans A. explorer

B. cartographer

C. designer

D. surveyor

Question Type : MCQ
Question ID : 4410091825716
Option 1 ID : 4410097197151
Option 2 ID : 4410097197152
Option 3 ID : 4410097197153
Option 4 ID : 4410097197150

Status : Answered
Chosen Option : A
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Sleep is a biological process that plays an essential role in maintaining human health. During sleep, the brain
performs several important tasks, including organizing memories, repairing tissues, and regulating hormones.
Researchers explain that sleep occurs in cycles that include rapid eye movement (REM) sleep and deeper non-
REM stages. These stages allow the brain to restore energy and process information gathered during the day.
According to sleep studies, teenagers generally require between eight and ten hours of sleep every night for
healthy development. However, many adolescents receive less sleep because of academic pressure, electronic
devices, and irregular daily schedules. Long-term sleep loss can affect mood, attention, and learning ability.
Scientists also emphasize that consistent sleep habits improve sleep quality. Maintaining a regular bedtime,
reducing screen exposure before sleeping, and creating a calm sleeping environment can help the body
maintain its natural rhythm. Adequate sleep supports physical health and mental clarity, while insufficient sleep
may gradually lead to fatigue, stress, and difficulty concentrating.

SubQuestion No : 61

Q.61 Select the option that best represents an appropriate title for the passage.

Ans A. The Biological Importance of Sleep

B. The Cultural Meaning of Rest

C. The Mechanical Nature of Memory

D. The Historical Study of Dreams

Question Type : MCQ
Question ID : 4410091819096
Option 1 ID : 4410097171665
Option 2 ID : 4410097171663
Option 3 ID : 4410097171662
Option 4 ID : 4410097171664

Status : Answered
Chosen Option : B
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Sleep is a biological process that plays an essential role in maintaining human health. During sleep, the brain
performs several important tasks, including organizing memories, repairing tissues, and regulating hormones.
Researchers explain that sleep occurs in cycles that include rapid eye movement (REM) sleep and deeper non-
REM stages. These stages allow the brain to restore energy and process information gathered during the day.
According to sleep studies, teenagers generally require between eight and ten hours of sleep every night for
healthy development. However, many adolescents receive less sleep because of academic pressure, electronic
devices, and irregular daily schedules. Long-term sleep loss can affect mood, attention, and learning ability.
Scientists also emphasize that consistent sleep habits improve sleep quality. Maintaining a regular bedtime,
reducing screen exposure before sleeping, and creating a calm sleeping environment can help the body
maintain its natural rhythm. Adequate sleep supports physical health and mental clarity, while insufficient sleep
may gradually lead to fatigue, stress, and difficulty concentrating.

SubQuestion No : 62

Q.62 Select the option that identifies a fact stated in the passage.

Ans A. Teenagers naturally prefer sleeping during daylight.

B. Sleep cycles include REM and non-REM stages.

C. Dreams always contain meaningful life messages.

D. Technology completely prevents healthy sleep.

Question Type : MCQ
Question ID : 4410091819097
Option 1 ID : 4410097171667
Option 2 ID : 4410097171666
Option 3 ID : 4410097171668
Option 4 ID : 4410097171669

Status : Answered
Chosen Option : B
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Sleep is a biological process that plays an essential role in maintaining human health. During sleep, the brain
performs several important tasks, including organizing memories, repairing tissues, and regulating hormones.
Researchers explain that sleep occurs in cycles that include rapid eye movement (REM) sleep and deeper non-
REM stages. These stages allow the brain to restore energy and process information gathered during the day.
According to sleep studies, teenagers generally require between eight and ten hours of sleep every night for
healthy development. However, many adolescents receive less sleep because of academic pressure, electronic
devices, and irregular daily schedules. Long-term sleep loss can affect mood, attention, and learning ability.
Scientists also emphasize that consistent sleep habits improve sleep quality. Maintaining a regular bedtime,
reducing screen exposure before sleeping, and creating a calm sleeping environment can help the body
maintain its natural rhythm. Adequate sleep supports physical health and mental clarity, while insufficient sleep
may gradually lead to fatigue, stress, and difficulty concentrating.

SubQuestion No : 63

Q.63 Select the option that best connects the passage to real-life situations.

Ans A. A student maintaining regular bedtime for better focus

B. A traveller collecting souvenirs from distant countries

C. A gardener planting flowers during heavy rainfall

D. A musician composing melodies for cultural festivals

Question Type : MCQ
Question ID : 4410091819098
Option 1 ID : 4410097171672
Option 2 ID : 4410097171673
Option 3 ID : 4410097171670
Option 4 ID : 4410097171671

Status : Answered
Chosen Option : B
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Sleep is a biological process that plays an essential role in maintaining human health. During sleep, the brain
performs several important tasks, including organizing memories, repairing tissues, and regulating hormones.
Researchers explain that sleep occurs in cycles that include rapid eye movement (REM) sleep and deeper non-
REM stages. These stages allow the brain to restore energy and process information gathered during the day.
According to sleep studies, teenagers generally require between eight and ten hours of sleep every night for
healthy development. However, many adolescents receive less sleep because of academic pressure, electronic
devices, and irregular daily schedules. Long-term sleep loss can affect mood, attention, and learning ability.
Scientists also emphasize that consistent sleep habits improve sleep quality. Maintaining a regular bedtime,
reducing screen exposure before sleeping, and creating a calm sleeping environment can help the body
maintain its natural rhythm. Adequate sleep supports physical health and mental clarity, while insufficient sleep
may gradually lead to fatigue, stress, and difficulty concentrating.

SubQuestion No : 64

Q.64 Select the option that identifies the tone of the passage.

Ans A. Critical and sarcastic

B. Emotional and dramatic

C. Informative and scientific

D. Humorous and playful

Question Type : MCQ
Question ID : 4410091819099
Option 1 ID : 4410097171677
Option 2 ID : 4410097171676
Option 3 ID : 4410097171675
Option 4 ID : 4410097171674

Status : Answered
Chosen Option : C
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Comprehension:

Read the given passage carefully and answer the questions that follow.

Sleep is a biological process that plays an essential role in maintaining human health. During sleep, the brain
performs several important tasks, including organizing memories, repairing tissues, and regulating hormones.
Researchers explain that sleep occurs in cycles that include rapid eye movement (REM) sleep and deeper non-
REM stages. These stages allow the brain to restore energy and process information gathered during the day.
According to sleep studies, teenagers generally require between eight and ten hours of sleep every night for
healthy development. However, many adolescents receive less sleep because of academic pressure, electronic
devices, and irregular daily schedules. Long-term sleep loss can affect mood, attention, and learning ability.
Scientists also emphasize that consistent sleep habits improve sleep quality. Maintaining a regular bedtime,
reducing screen exposure before sleeping, and creating a calm sleeping environment can help the body
maintain its natural rhythm. Adequate sleep supports physical health and mental clarity, while insufficient sleep
may gradually lead to fatigue, stress, and difficulty concentrating.

SubQuestion No : 65

Q.65 Select the option that provides the antonym of the word “adequate” used in the
passage.

Ans A. Insufficient

B. Essential

C. Natural

D. Physical

Question Type : MCQ
Question ID : 4410091819100
Option 1 ID : 4410097171679
Option 2 ID : 4410097171680
Option 3 ID : 4410097171681
Option 4 ID : 4410097171678

Status : Answered
Chosen Option : A

Q.66 ସଠିକ ଶବ୍ଦ ଚୟନ କର।
‘ଫୁଲ’ ଶବ୍ଦଟି କେଉଁ  ପ୍ରକାରର?

Ans A. ଦେଶଜ

B. ତତ୍ସମ

C. ବିଦେଶଜ

D. ତଦ୍ଭବ

Question Type : MCQ
Question ID : 4410091046582
Option 1 ID : 4410094135383
Option 2 ID : 4410094135381
Option 3 ID : 4410094135384
Option 4 ID : 4410094135382

Status : Answered
Chosen Option : A

Section : Odia
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Q.67 ଶିଶୁ ______ ଶୋଇଛି । ଶବ୍ଦ କରନାହିଁ।

Ans A. ନିଦରେ

B. ଏହିକ୍ଷଣି

C. ଗଭୀର

D. ନିଦ୍ରାଳୁ

Question Type : MCQ
Question ID : 4410091675757
Option 1 ID : 4410096611867
Option 2 ID : 4410096611865
Option 3 ID : 4410096611864
Option 4 ID : 4410096611866

Status : Answered
Chosen Option : A

Q.68 ନିମ୍ନଲିଖିତ ବିକଳ୍ପମାନଙ୍କୁ ମଧ୍ୟରୁ  ଇଂରାଜୀ ବାକ୍ୟର ସଠିକ୍ ଓଡ଼ିଆ ଅନୁବାଦ ପସନ୍ଦ କରନ୍ତୁ:

The teacher encouraged students to participate in the science quiz.

Ans A. ଶିକ୍ଷକ କ୍ରୀଡା ପ୍ରଶ୍ନୋତ୍ତରରେ ଛାତ୍ରମାନଙ୍କୁ ଯୋଗଦେବାକୁ ପ୍ରେରଣା ଦେଲେ।

B. ଶିକ୍ଷକ କଳା ପ୍ରଶ୍ନୋତ୍ତରରେ ଛାତ୍ରମାନଙ୍କୁ ଯୋଗଦେବାକୁ ପ୍ରେରଣା ଦେଲେ।

C. ଶିକ୍ଷକ ବିଜ୍ଞାନ ପ୍ରଶ୍ନୋତ୍ତରରେ ଛାତ୍ରମାନଙ୍କୁ ଯୋଗଦେବାକୁ ପ୍ରେରଣା ଦେଲେ।

D. ଶିକ୍ଷକ ସାହିତ୍ୟ ପ୍ରଶ୍ନୋତ୍ତରରେ ଛାତ୍ରମାନଙ୍କୁ ଯୋଗଦେବାକୁ ପ୍ରେରଣା ଦେଲେ।

Question Type : MCQ
Question ID : 4410091202254
Option 1 ID : 4410094742780
Option 2 ID : 4410094742779
Option 3 ID : 4410094742778
Option 4 ID : 4410094742781

Status : Answered
Chosen Option : C

Q.69 ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ସମାନାର୍ଥକ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ଇଚ୍ଛା

Ans A. ଲୋଭ

B. ଅନିଚ୍ଛା

C. ଆକାଂକ୍ଷା

D. ନିରାଶା

Question Type : MCQ
Question ID : 4410091199576
Option 1 ID : 4410094732121
Option 2 ID : 4410094732123
Option 3 ID : 4410094732120
Option 4 ID : 4410094732122

Status : Answered
Chosen Option : B

5/16/26, 11:35 AM cdn3.digialm.com//per/g26/pub/33040/touchstone/AssessmentQPHTMLMode1//33040O261/33040O261S20D1366/17780622786…

https://cdn3.digialm.com//per/g26/pub/33040/touchstone/AssessmentQPHTMLMode1//33040O261/33040O261S20D1366/17780622786365662/16… 28/42

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Q.70 ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସବୁଠାରୁ  ଉପଯୁକ୍ତ ଇଂରାଜୀ ଅନୁବାଦ ବିକଳ୍ପ ବାଛନ୍ତୁ।

ବହୁ ପରିଶ୍ରମ କରିବା ସତ୍ତ୍ୱେ ଛାତ୍ରଛାତ୍ରୀମାନେ ଆଇଏଏସ ପାଇପାରୁ ନାହାନ୍ତି।

Ans A. Despite working hard, students have not got into IAS.

B. Despite working hard, students are not able get into IAS.

C. Despite working hard, students will not able to get IAS.

D. Despite working hard, students can not to get into IAS.

Question Type : MCQ
Question ID : 4410091232497
Option 1 ID : 4410094863747
Option 2 ID : 4410094863746
Option 3 ID : 4410094863745
Option 4 ID : 4410094863744

Status : Answered
Chosen Option : A

Q.71 ଆମେ ପ୍ରତି ରବିବାର ପାର୍କକୁ ______।

Ans A. ଯାଆନ୍ତୁ

B. ଯାଇଥି ଲି

C. ଯାଉ

D. ଯାଉଛି

Question Type : MCQ
Question ID : 4410091675585
Option 1 ID : 4410096611260
Option 2 ID : 4410096611263
Option 3 ID : 4410096611262
Option 4 ID : 4410096611261

Status : Answered
Chosen Option : C

Q.72 ଏକ ଉପଯୁକ୍ତ ବିକଳ୍ପ ସାହାଯ୍ୟରେ ଶୂନ୍ୟସ୍ଥାନ ପୂରଣ କରନ୍ତୁ।
ପଢିବା ସମୟରେ _______ ବିରକ୍ତ କରିବା ଉଚିତ ନୁହେଁ ।

Ans A. କାହାକୁ

B. ଉପରେ

C. ତୁ ମର

D. ଯାହାକୁ

Question Type : MCQ
Question ID : 4410091236510
Option 1 ID : 4410094879618
Option 2 ID : 4410094879620
Option 3 ID : 4410094879617
Option 4 ID : 4410094879619

Status : Answered
Chosen Option : A
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Q.73 ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ବିପରୀତ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ
ଅଜଣା

Ans A. ଜଣା

B. ଅଶୁଣା

C. ଅଚିହ୍ନା

D. ଅଜ୍ଞାତ

Question Type : MCQ
Question ID : 4410091676059
Option 1 ID : 4410096613057
Option 2 ID : 4410096613058
Option 3 ID : 4410096613056
Option 4 ID : 4410096613059

Status : Answered
Chosen Option : A

Q.74 ବେଙ୍ଗ'ର ସମାନାର୍ଥବୋଧକ ଶବ୍ଦ କଣ?

Ans A. ଭେକ

B. ତୁରଗ

C. ପୟର

D. ଜୋକ

Question Type : MCQ
Question ID : 4410091194286
Option 1 ID : 4410094711058
Option 2 ID : 4410094711061
Option 3 ID : 4410094711060
Option 4 ID : 4410094711059

Status : Answered
Chosen Option : A

Q.75 ନିମ୍ନଲିଖିତ ବିକଳ୍ପଗୁଡ଼ିକ ମଧ୍ୟରୁ  ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସଠିକ୍ ଇଂରାଜୀ ଅନୁବାଦ ବାଛନ୍ତୁ:
ସୁନାର ଦର ଆଜି ବଢ଼ିଛି।

Ans A. The price of gold will increase yesterday.

B. The price of gold has increased today.

C. The price of gold is increase today.

D. The price of gold increased tomorrow.

Question Type : MCQ
Question ID : 4410091201742
Option 1 ID : 4410094740754
Option 2 ID : 4410094740752
Option 3 ID : 4410094740755
Option 4 ID : 4410094740753

Status : Answered
Chosen Option : C
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

ପରିଶ୍ରମ ହେଉଛି ସଫଳତାର ମୂଳମନ୍ତ୍ର। ଯେ ମଣିଷ ପରିଶ୍ରମ କରେ, ସେ ଜୀବନରେ ନିଶ୍ଚୟ ସଫଳ ହୁଏ। ଯେପରି ଚାଷୀ ଦିନରାତି ଶ୍ରମ କରି
ଫସଲ ଉତ୍ପାଦନ କରେ, ସେପରି ଜୀବନର ସମସ୍ତ କ୍ଷେତ୍ରରେ ପରିଶ୍ରମ ଆବଶ୍ୟକ। ଭଗବାନ ମଧ୍ୟ ସେମାନଙ୍କୁ ଭଲପାଆନ୍ତି, ଯେମାନେ ନିଜ କର୍ମ
ପ୍ରତି ନିଷ୍ଠା ଶୀଳ ଓ ପରିଶ୍ରମୀ।

ଆଳସ୍ୟ ହେଉଛି ଜୀବନର ଶତୃ । ଯେ ମଣିଷ ଆଳସ୍ୟ କରେ, ସେ ତାହାର ସମୟ, ଶକ୍ତି ଓ ସୁଯୋଗକୁ ହାରାଏ। ପରିଶ୍ରମୀ ମଣିଷ କେବେ ହାର
ମାନେନି, ସେ ଚେଷ୍ଟା କରି ଯାଏ ଯେପର୍ଯ୍ୟନ୍ତ ଲକ୍ଷ୍ୟ ପାଇଁ  ନ ପହଞ୍ଚେ।

ପୃଥି ବୀର ସମସ୍ତ ବଡ଼ ମଣିଷମାନେ — ବିଜ୍ଞାନୀ, ଶିକ୍ଷକ, ନେତା ଓ ଶିଳ୍ପୀ — ସମସ୍ତେ ନିଜ ପରିଶ୍ରମରେ ଶ୍ରେଷ୍ଠ ହୋଇଥି ଲେ। ସେମାନଙ୍କ ସଫଳତା
ହଠାତ୍  ଆସିନାହିଁ; ସେ ଦିନରାତି ହାର ନମାନି କାମ କରିଥି ଲେ।

ଏହିପରି, ଆମେ ସବୁବେଳେ ପରିଶ୍ରମକୁ ଜୀବନର ଅଂଶ କରିବା ଉଚିତ। ପରିଶ୍ରମ ଆମକୁ ନିଜେ ଉପରେ ବିଶ୍ୱାସ ଓ ସଫଳତା ଦିଏ।

SubQuestion No : 76

Q.76 ଗଦ୍ୟାଂଶପାଇଁ  ଉପଯୁକ୍ତ ଶୀର୍ଷକ ଚିହ୍ନଟ କର।

Ans A. ସଫଳତାର ମାର୍ଗ

B. ଭଗବାନ ଓ ମଣିଷ

C. ପରିଶ୍ରମର ମହତ୍ତ୍ୱ

D. ଆଳସ୍ୟର କୁଫଳ

Question Type : MCQ
Question ID : 4410091485935
Option 1 ID : 4410095870199
Option 2 ID : 4410095870200
Option 3 ID : 4410095870198
Option 4 ID : 4410095870197

Status : Answered
Chosen Option : A
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

ପରିଶ୍ରମ ହେଉଛି ସଫଳତାର ମୂଳମନ୍ତ୍ର। ଯେ ମଣିଷ ପରିଶ୍ରମ କରେ, ସେ ଜୀବନରେ ନିଶ୍ଚୟ ସଫଳ ହୁଏ। ଯେପରି ଚାଷୀ ଦିନରାତି ଶ୍ରମ କରି
ଫସଲ ଉତ୍ପାଦନ କରେ, ସେପରି ଜୀବନର ସମସ୍ତ କ୍ଷେତ୍ରରେ ପରିଶ୍ରମ ଆବଶ୍ୟକ। ଭଗବାନ ମଧ୍ୟ ସେମାନଙ୍କୁ ଭଲପାଆନ୍ତି, ଯେମାନେ ନିଜ କର୍ମ
ପ୍ରତି ନିଷ୍ଠା ଶୀଳ ଓ ପରିଶ୍ରମୀ।

ଆଳସ୍ୟ ହେଉଛି ଜୀବନର ଶତୃ । ଯେ ମଣିଷ ଆଳସ୍ୟ କରେ, ସେ ତାହାର ସମୟ, ଶକ୍ତି ଓ ସୁଯୋଗକୁ ହାରାଏ। ପରିଶ୍ରମୀ ମଣିଷ କେବେ ହାର
ମାନେନି, ସେ ଚେଷ୍ଟା କରି ଯାଏ ଯେପର୍ଯ୍ୟନ୍ତ ଲକ୍ଷ୍ୟ ପାଇଁ  ନ ପହଞ୍ଚେ।

ପୃଥି ବୀର ସମସ୍ତ ବଡ଼ ମଣିଷମାନେ — ବିଜ୍ଞାନୀ, ଶିକ୍ଷକ, ନେତା ଓ ଶିଳ୍ପୀ — ସମସ୍ତେ ନିଜ ପରିଶ୍ରମରେ ଶ୍ରେଷ୍ଠ ହୋଇଥି ଲେ। ସେମାନଙ୍କ ସଫଳତା
ହଠାତ୍  ଆସିନାହିଁ; ସେ ଦିନରାତି ହାର ନମାନି କାମ କରିଥି ଲେ।

ଏହିପରି, ଆମେ ସବୁବେଳେ ପରିଶ୍ରମକୁ ଜୀବନର ଅଂଶ କରିବା ଉଚିତ। ପରିଶ୍ରମ ଆମକୁ ନିଜେ ଉପରେ ବିଶ୍ୱାସ ଓ ସଫଳତା ଦିଏ।

SubQuestion No : 77

Q.77 ଅନୁଚ୍ଛେଦର ସ୍ୱରକୁ ଚିହ୍ନଟ କର।

Ans A. ରୋଷପୂର୍ଣ୍ଣ

B. ବିନୋଦନମୂଳକ

C. ଦୁଃଖଦ

D. ପ୍ରେରଣାଦାୟକ

Question Type : MCQ
Question ID : 4410091485936
Option 1 ID : 4410095870204
Option 2 ID : 4410095870203
Option 3 ID : 4410095870202
Option 4 ID : 4410095870201

Status : Answered
Chosen Option : A
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

ପରିଶ୍ରମ ହେଉଛି ସଫଳତାର ମୂଳମନ୍ତ୍ର। ଯେ ମଣିଷ ପରିଶ୍ରମ କରେ, ସେ ଜୀବନରେ ନିଶ୍ଚୟ ସଫଳ ହୁଏ। ଯେପରି ଚାଷୀ ଦିନରାତି ଶ୍ରମ କରି
ଫସଲ ଉତ୍ପାଦନ କରେ, ସେପରି ଜୀବନର ସମସ୍ତ କ୍ଷେତ୍ରରେ ପରିଶ୍ରମ ଆବଶ୍ୟକ। ଭଗବାନ ମଧ୍ୟ ସେମାନଙ୍କୁ ଭଲପାଆନ୍ତି, ଯେମାନେ ନିଜ କର୍ମ
ପ୍ରତି ନିଷ୍ଠା ଶୀଳ ଓ ପରିଶ୍ରମୀ।

ଆଳସ୍ୟ ହେଉଛି ଜୀବନର ଶତୃ । ଯେ ମଣିଷ ଆଳସ୍ୟ କରେ, ସେ ତାହାର ସମୟ, ଶକ୍ତି ଓ ସୁଯୋଗକୁ ହାରାଏ। ପରିଶ୍ରମୀ ମଣିଷ କେବେ ହାର
ମାନେନି, ସେ ଚେଷ୍ଟା କରି ଯାଏ ଯେପର୍ଯ୍ୟନ୍ତ ଲକ୍ଷ୍ୟ ପାଇଁ  ନ ପହଞ୍ଚେ।

ପୃଥି ବୀର ସମସ୍ତ ବଡ଼ ମଣିଷମାନେ — ବିଜ୍ଞାନୀ, ଶିକ୍ଷକ, ନେତା ଓ ଶିଳ୍ପୀ — ସମସ୍ତେ ନିଜ ପରିଶ୍ରମରେ ଶ୍ରେଷ୍ଠ ହୋଇଥି ଲେ। ସେମାନଙ୍କ ସଫଳତା
ହଠାତ୍  ଆସିନାହିଁ; ସେ ଦିନରାତି ହାର ନମାନି କାମ କରିଥି ଲେ।

ଏହିପରି, ଆମେ ସବୁବେଳେ ପରିଶ୍ରମକୁ ଜୀବନର ଅଂଶ କରିବା ଉଚିତ। ପରିଶ୍ରମ ଆମକୁ ନିଜେ ଉପରେ ବିଶ୍ୱାସ ଓ ସଫଳତା ଦିଏ।

SubQuestion No : 78

Q.78 ଅନୁଚ୍ଛେଦରେ ଦିଆଯାଇଥିବା ତଥ୍ୟଗୁଡ଼ିକୁ ଚିହ୍ନଟ କର।

Ans A. ଆଳସ୍ୟ ହେଉଛି ଶତୃ ।

B. ଭଗବାନ ଓ ମଣିଷ

C. ସମସ୍ତ

D. ଆଳସ୍ୟର କୁଫଳ

Question Type : MCQ
Question ID : 4410091485937
Option 1 ID : 4410095870206
Option 2 ID : 4410095870207
Option 3 ID : 4410095870208
Option 4 ID : 4410095870205

Status : Answered
Chosen Option : C
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

ପରିଶ୍ରମ ହେଉଛି ସଫଳତାର ମୂଳମନ୍ତ୍ର। ଯେ ମଣିଷ ପରିଶ୍ରମ କରେ, ସେ ଜୀବନରେ ନିଶ୍ଚୟ ସଫଳ ହୁଏ। ଯେପରି ଚାଷୀ ଦିନରାତି ଶ୍ରମ କରି
ଫସଲ ଉତ୍ପାଦନ କରେ, ସେପରି ଜୀବନର ସମସ୍ତ କ୍ଷେତ୍ରରେ ପରିଶ୍ରମ ଆବଶ୍ୟକ। ଭଗବାନ ମଧ୍ୟ ସେମାନଙ୍କୁ ଭଲପାଆନ୍ତି, ଯେମାନେ ନିଜ କର୍ମ
ପ୍ରତି ନିଷ୍ଠା ଶୀଳ ଓ ପରିଶ୍ରମୀ।

ଆଳସ୍ୟ ହେଉଛି ଜୀବନର ଶତୃ । ଯେ ମଣିଷ ଆଳସ୍ୟ କରେ, ସେ ତାହାର ସମୟ, ଶକ୍ତି ଓ ସୁଯୋଗକୁ ହାରାଏ। ପରିଶ୍ରମୀ ମଣିଷ କେବେ ହାର
ମାନେନି, ସେ ଚେଷ୍ଟା କରି ଯାଏ ଯେପର୍ଯ୍ୟନ୍ତ ଲକ୍ଷ୍ୟ ପାଇଁ  ନ ପହଞ୍ଚେ।

ପୃଥି ବୀର ସମସ୍ତ ବଡ଼ ମଣିଷମାନେ — ବିଜ୍ଞାନୀ, ଶିକ୍ଷକ, ନେତା ଓ ଶିଳ୍ପୀ — ସମସ୍ତେ ନିଜ ପରିଶ୍ରମରେ ଶ୍ରେଷ୍ଠ ହୋଇଥି ଲେ। ସେମାନଙ୍କ ସଫଳତା
ହଠାତ୍  ଆସିନାହିଁ; ସେ ଦିନରାତି ହାର ନମାନି କାମ କରିଥି ଲେ।

ଏହିପରି, ଆମେ ସବୁବେଳେ ପରିଶ୍ରମକୁ ଜୀବନର ଅଂଶ କରିବା ଉଚିତ। ପରିଶ୍ରମ ଆମକୁ ନିଜେ ଉପରେ ବିଶ୍ୱାସ ଓ ସଫଳତା ଦିଏ।

SubQuestion No : 79

Q.79 ଅନ୍ୟାନ୍ୟ ଉଦାହରଣରେ “ଆଳସ୍ୟ” ଶବ୍ଦର ସଠିକ ବ୍ୟବହାର କର।

Ans A. ଆଳସ୍ୟ ଆମକୁ ସୁଖ ଦିଏ।

B. ଆଳସ୍ୟ ହେଉଛି ମିତ୍ର।

C. ଆଳସ୍ୟ ଆମକୁ ଅସଫଳ କରେ।

D. ଆଳସ୍ୟ ଆମେ ଖାଇବାକୁ ଯାଉ।

Question Type : MCQ
Question ID : 4410091485938
Option 1 ID : 4410095870212
Option 2 ID : 4410095870211
Option 3 ID : 4410095870209
Option 4 ID : 4410095870210

Status : Answered
Chosen Option : C
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

ପରିଶ୍ରମ ହେଉଛି ସଫଳତାର ମୂଳମନ୍ତ୍ର। ଯେ ମଣିଷ ପରିଶ୍ରମ କରେ, ସେ ଜୀବନରେ ନିଶ୍ଚୟ ସଫଳ ହୁଏ। ଯେପରି ଚାଷୀ ଦିନରାତି ଶ୍ରମ କରି
ଫସଲ ଉତ୍ପାଦନ କରେ, ସେପରି ଜୀବନର ସମସ୍ତ କ୍ଷେତ୍ରରେ ପରିଶ୍ରମ ଆବଶ୍ୟକ। ଭଗବାନ ମଧ୍ୟ ସେମାନଙ୍କୁ ଭଲପାଆନ୍ତି, ଯେମାନେ ନିଜ କର୍ମ
ପ୍ରତି ନିଷ୍ଠା ଶୀଳ ଓ ପରିଶ୍ରମୀ।

ଆଳସ୍ୟ ହେଉଛି ଜୀବନର ଶତୃ । ଯେ ମଣିଷ ଆଳସ୍ୟ କରେ, ସେ ତାହାର ସମୟ, ଶକ୍ତି ଓ ସୁଯୋଗକୁ ହାରାଏ। ପରିଶ୍ରମୀ ମଣିଷ କେବେ ହାର
ମାନେନି, ସେ ଚେଷ୍ଟା କରି ଯାଏ ଯେପର୍ଯ୍ୟନ୍ତ ଲକ୍ଷ୍ୟ ପାଇଁ  ନ ପହଞ୍ଚେ।

ପୃଥି ବୀର ସମସ୍ତ ବଡ଼ ମଣିଷମାନେ — ବିଜ୍ଞାନୀ, ଶିକ୍ଷକ, ନେତା ଓ ଶିଳ୍ପୀ — ସମସ୍ତେ ନିଜ ପରିଶ୍ରମରେ ଶ୍ରେଷ୍ଠ ହୋଇଥି ଲେ। ସେମାନଙ୍କ ସଫଳତା
ହଠାତ୍  ଆସିନାହିଁ; ସେ ଦିନରାତି ହାର ନମାନି କାମ କରିଥି ଲେ।

ଏହିପରି, ଆମେ ସବୁବେଳେ ପରିଶ୍ରମକୁ ଜୀବନର ଅଂଶ କରିବା ଉଚିତ। ପରିଶ୍ରମ ଆମକୁ ନିଜେ ଉପରେ ବିଶ୍ୱାସ ଓ ସଫଳତା ଦିଏ।

SubQuestion No : 80

Q.80 ବିପରୀତ ଶବ୍ଦ (Antonym) ଚିହ୍ଣ ଟ କର – “ପରିଶ୍ରମୀ”

Ans A. ଆଳସୀ

B. ସାଧୁ

C. ନିଷ୍ଠା ଶୀଳ

D. ଦୟାଳୁ

Question Type : MCQ
Question ID : 4410091485939
Option 1 ID : 4410095870213
Option 2 ID : 4410095870216
Option 3 ID : 4410095870215
Option 4 ID : 4410095870214

Status : Answered
Chosen Option : A

Q.81 ମାଇକ୍ରୋସଫ୍ଟ  ପାୱାରପଏଣ୍ଟ 2021 ରେ କରେଣ୍ଟ ସ୍ଲାଇଡରୁ  ପ୍ରେଜେଣ୍ଟ କରିବା ପାଇଁ  ସର୍ଟକଟ କୀ କ’ଣ ଅଟେ?

Ans A. Shift + F5

B. F5

C. F1

D. Shift + F9

Question Type : MCQ
Question ID : 4410091478523
Option 1 ID : 4410095841430
Option 2 ID : 4410095841427
Option 3 ID : 4410095841429
Option 4 ID : 4410095841428

Status : Answered
Chosen Option : A

Section : Computer
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Q.82 ଏକ ନିର୍ଦ୍ଦିଷ୍ଟ ସମୟ ପରେ ସ୍ଲାଇଡଗୁଡ଼ିକୁ ସ୍ଵତଃସ୍ଫୃତ ଆଗକୁ ବଢାଇବା (advance) ପାଇଁ  ଆପଣ _________
ବ୍ୟବହାର କରନ୍ତି ।

Ans A. Slide Timing option

B. Layout Tab

C. Animation Pane

D. Format Menu

Question Type : MCQ
Question ID : 4410091449112
Option 1 ID : 4410095724908
Option 2 ID : 4410095724911
Option 3 ID : 4410095724909
Option 4 ID : 4410095724910

Status : Answered
Chosen Option : A

Q.83 ଫଟୋଗ୍ରାଫ୍ , ଗ୍ରାଫି କ୍ସ କିମ୍ବା ୱେବ୍ ଭିଜୁଆଲ୍  ଭଳି ଫର୍ମାଟରେ ଡିଜିଟାଲ୍  ଇମେଜ ଷ୍ଟୋର କରିବା ପାଇଁ  ମୁଖ୍ୟତଃ କେଉଁ
ଫାଇଲ ପ୍ରକାର ବ୍ୟବହୃତ ହୁଏ?

Ans A. .jpg

B. .txt

C. .mp3

D. .exe

Question Type : MCQ
Question ID : 4410091425365
Option 1 ID : 4410095630067
Option 2 ID : 4410095630069
Option 3 ID : 4410095630068
Option 4 ID : 4410095630070

Status : Answered
Chosen Option : A

Q.84 ନିମ୍ନଲିଖିତ ମଧ୍ୟରୁ  କେଉଁ ଟି ଆଣ୍ଟିଭାଇରସ ସଫ୍ଟୱେରକୁ ସଠିକ ଭାବରେ ବାଖ୍ୟା କରେ ?

Ans A. ଏହା ଏକ ସଫ୍ଟୱେର ଯାହା ଇଣ୍ଟରନେଟ କନେକ୍ସନକୁ ତ୍ୱରାନ୍ୱି ତ କରିବାରେ ସାହାଯ୍ୟ କରେ

B. ଏହା ଏକ ସିଷ୍ଟମ ଯାହା ଡିସ୍କ ସ୍ପେସକୁ ମ୍ୟାନେଜ କରେ

C. ଏହା ଏକ ସଫ୍ଟୱେର ଯାହା କମ୍ପ୍ୟୁଟର ଭାଇରସ ଏବଂ ଅନ୍ୟ ମାଲୱେରଗୁଡିକୁ ଡିଟେକ୍ଟ ଏବଂ ରିମୁଭ କରିବା ପାଇଁ  ଡିଜାଇନ
କରାଯାଇଛି

D. ଏହା ଏକ ହାର୍ଡୱେର ଡିଭାଇସ ଯାହା ଗୋଟେ କମ୍ପ୍ୟୁଟରକୁ ଓଭରହିଟିଙ୍ଗରୁ  ପ୍ରୋଟେକ୍ଟ କରେ

Question Type : MCQ
Question ID : 4410091462447
Option 1 ID : 4410095777901
Option 2 ID : 4410095777899
Option 3 ID : 4410095777900
Option 4 ID : 4410095777898

Status : Answered
Chosen Option : C
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Q.85 ୱାର୍କବୁକର ସମସ୍ତ ୱାର୍କସିଟକୁ ଏକାସାଙ୍ଗରେ ପ୍ରିଣ୍ଟ କରିବା ପାଇଁ  ଆବଶ୍ୟକୀୟ ଅପସନ ଚିହ୍ନଟ କର ।

Ans A. File → Save As → Print

B. File → Print → Active Sheets

C. File → Export → PDF

D. File → Print → Entire Workbook

Question Type : MCQ
Question ID : 4410091450329
Option 1 ID : 4410095729836
Option 2 ID : 4410095729834
Option 3 ID : 4410095729837
Option 4 ID : 4410095729835

Status : Answered
Chosen Option : D

Q.86 ଡିଜିଟାଲ ୱାଲେଟ କ'ଣ ଅଟେ?

Ans A. ଫି ଜିକାଲ ଡେବିଟ କାର୍ଡ

B. ବ୍ୟାଙ୍କ ଆକାଉଣ୍ଟ

C. ଫି ଜିକାଲ କ୍ରେଡିଟ କାର୍ଡ

D. ଇଲେକ୍ଟ୍ରୋ ନିକ କାର୍ଡ

Question Type : MCQ
Question ID : 4410091478630
Option 1 ID : 4410095841847
Option 2 ID : 4410095841848
Option 3 ID : 4410095841846
Option 4 ID : 4410095841849

Status : Answered
Chosen Option : B

Q.87 ଯଦି ଆପଣ “Jan”, “Feb” ଥିବା ସେଲଗୁଡିକ ପାଇଁ  ଫି ଲ ହ୍ୟାଣ୍ଡେଲ (fill handle) ଡ୍ରାଗ କରନ୍ତି, ତେବେ ଏକ୍ସେଲ
କ’ଣ ଫି ଲ (fill) କରିବ?

Ans A. Jan, Feb, Jan, Feb...

B. Days of the week

C. Mar, Apr, May...

D. 1, 2, 3...

Question Type : MCQ
Question ID : 4410091432645
Option 1 ID : 4410095659050
Option 2 ID : 4410095659052
Option 3 ID : 4410095659053
Option 4 ID : 4410095659051

Status : Answered
Chosen Option : A
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Q.88 ଡିପ୍ଲୟମେଣ୍ଟ ପୂର୍ବରୁ  ଆପ୍ଲି କେସନ ସୋର୍ସ କୋଡରେ ଭଲନରେବିଲିଟି (vulnerabilities) ଚିହ୍ନଟ କରିବା ପାଇଁ
ନିମ୍ନଲିଖିତ କେଉଁ  ଟେକ୍ନିକ ବ୍ୟବହୃତ ହୁଏ?

Ans A. କେବଳ ଷ୍ଟାଟିକ ଆପ୍ଲି କେସନ ସିକ୍ୟୁରିଟି ଟେଷ୍ଟିଙ୍ଗ (SAST)

B. କେବଳ ଡାଇନାମିକ ଆପ୍ଲି କେସନ ସିକ୍ୟୁରିଟି ଟେଷ୍ଟିଙ୍ଗ (DAST)

C. ଉଭୟ ଷ୍ଟାଟିକ ଆପ୍ଲି କେସନ ସିକ୍ୟୁରିଟି ଟେଷ୍ଟିଙ୍ଗ (SAST) ଏବଂ ଡାଇନାମିକ ଆପ୍ଲି କେସନ ସିକ୍ୟୁରିଟି ଟେଷ୍ଟିଙ୍ଗ (DAST)

D. କୌଣସି ଟେଷ୍ଟିଙ୍ଗ ନୁହେଁ  - କେବଳ ଫାୟାରୱାଲ ମନିଟରିଙ୍ଗ ପୋଷ୍ଟ-ଡିପ୍ଲ ୟମେଣ୍ଟ ଅଟେ

Question Type : MCQ
Question ID : 4410091453473
Option 1 ID : 4410095742180
Option 2 ID : 4410095742179
Option 3 ID : 4410095742181
Option 4 ID : 4410095742182

Status : Not Answered
Chosen Option : --

Q.89 MS ୱାର୍ଡ 365 ରେ "Save As" ବ୍ୟବହାର କରି କେଉଁ  ଫାଇଲ ଫର୍ମାଟ ଚୟନ କରାଯାଇପାରିବ, ଯାହା ଦ୍ୱାରା
ଡକ୍ୟୁମେଣ୍ଟ ଲେଆଉଟକୁ ସଂରକ୍ଷଣ କରି ରଖାଯାଇପାରିବ ଏବଂ ଏହା ସହଜରେ ଏଡିଟ ହେବାରେ ରୋକିବ?

Ans A. .docx

B. .pdf

C. .rtf

D. .txt

Question Type : MCQ
Question ID : 4410091445853
Option 1 ID : 4410095712061
Option 2 ID : 4410095712063
Option 3 ID : 4410095712064
Option 4 ID : 4410095712062

Status : Answered
Chosen Option : B

Q.90 ନିମ୍ନଲିଖିତ କେଉଁ ଟି ସିଷ୍ଟମ ସଫ୍ଟୱେର ଏବଂ ଆପ୍ଲି କେସନ ସଫ୍ଟୱେର ମଧ୍ୟରେ ଥିବା ସମ୍ପର୍କକୁ ସଠିକ ଭାବରେ ବର୍ଣ୍ଣନା
କରେ?

Ans A. ଆପ୍ଲି କେସନ ସଫ୍ଟୱେର ସିଷ୍ଟମ ସଫ୍ଟୱେୟାରର ସପୋର୍ଟ ବିନା ଫଙ୍କସନ କରିପାରେ ।

B. ସିଷ୍ଟମ ସଫ୍ଟୱେର ଏହାର ବେସିକ ଅପରେସନ ପାଇଁ  ଆପ୍ଲି କେସନ ସଫ୍ଟୱେର ଉପରେ ନିର୍ଭର କରେ ।

C. ସିଷ୍ଟମ ସଫ୍ଟୱେର ଆପ୍ଲି କେସନ ସଫ୍ଟୱେର ରନ କରିବା ପାଇଁ  ଏନଭର୍ଣ୍ଣର୍ମେଣ୍ଟ ପ୍ରଦାନ କରେ ।

D. ଉଭୟ ପ୍ରକାରର ସଫ୍ଟୱେର ସମାନ ପ୍ରକାରର ଅପରେସନ ସମ୍ପାଦନ କରନ୍ତି ।

Question Type : MCQ
Question ID : 4410091439586
Option 1 ID : 4410095687008
Option 2 ID : 4410095687009
Option 3 ID : 4410095687010
Option 4 ID : 4410095687011

Status : Answered
Chosen Option : D
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Q.91 କେଉଁ  ଇଣ୍ଟରନେଟ କମ୍ୟୁନିକେଶନ ସର୍ଭିସ ମୂଳତଃ ନ୍ୟୁଜ ଗୃପରେ ଡିସ୍କସନ ଆର୍ଟିକିଲ ବିତରଣ ପାଇଁ  NNTP
(ନେଟୱାର୍କ ନ୍ୟୁଜ ଟ୍ରାନ୍ସଫର ପ୍ରୋଟୋକଲ) ବ୍ୟବହାର କରାଯାଏ?

Ans A. Telnet Forums

B. Gopher

C. Usenet

D. IRC

Question Type : MCQ
Question ID : 4410091459578
Option 1 ID : 4410095766477
Option 2 ID : 4410095766478
Option 3 ID : 4410095766476
Option 4 ID : 4410095766475

Status : Answered
Chosen Option : D

Q.92 ଏକ MS 365 ଏକ୍ସେଲ ୱାର୍କସିଟରେ Row 5 ର ଠିକ ଉପରେ ଏକ ନୂଆ ବ୍ଲାଙ୍କ ରୋ (new blank row) ଇନସର୍ଟ
କରିବାର ସବୁଠାରୁ  ଦ୍ରୁତ ଏବଂ ସହଜ ଉପାୟ କ’ଣ ଅଟେ?

Ans A. Row 5 ରେ ଥି ବା ଯେକୌଣସି ସେଲ ଉପରେ କ୍ଲିକ କରିବା, HOME ଟ୍ୟାବକୁ ଯିବା, Format ଉପରେ କ୍ଲିକ କରିବା ଏବଂ Insert
Cells ସିଲେକ୍ଟ କରିବା

B. ସେଲ A5 ଉପରେ ରାଇଟ-କ୍ଲିକ କରିବା ଏବଂ ADD > Entire Row ସିଲେକ୍ଟ କରିବା

C. ରୋ ନମ୍ବର 5 ହେଡିଙ୍ଗ ଉପରେ କ୍ଲିକ କରିବା ଏବଂ ତା'ପରେ ରାଇଟ-କ୍ଲିକ ମେନୁରୁ  Insert ସିଲେକ୍ଟ କରିବା

D. କୀବୋର୍ଡ ସର୍ଟକଟ Ctrl + I କୁ ପ୍ରେସ କରିବା

Question Type : MCQ
Question ID : 4410091430990
Option 1 ID : 4410095652272
Option 2 ID : 4410095652273
Option 3 ID : 4410095652274
Option 4 ID : 4410095652275

Status : Answered
Chosen Option : A

Q.93 ନିମ୍ନଲିଖିତ ମଧ୍ୟରୁ  କେଉଁ ଟି କମ୍ପ୍ୟୁଟର ସିକ୍ୟୁରିଟି ର ଏକ ପ୍ରକାର ନୁହେଁ ?

Ans A. ଆପ୍ଲି କେସନ ସିକ୍ୟୁରିଟି

B. ନେଟୱାର୍କ ସିକ୍ୟୁରିଟି

C. ଇନଫରମେସନ ସିକ୍ୟୁରିଟି

D. ନେଟୱାର୍କ କେବୁଲ ସିକ୍ୟୁରିଟି

Question Type : MCQ
Question ID : 4410091444404
Option 1 ID : 4410095706234
Option 2 ID : 4410095706235
Option 3 ID : 4410095706236
Option 4 ID : 4410095706233

Status : Answered
Chosen Option : D
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Q.94 ସଂକ୍ଷିପ୍ତାକ୍ଷର CPU ରେ “U” ଅକ୍ଷରର ଅର୍ଥ କ'ଣ?

Ans A. ୟୁ ଟିଲିଟି (Utility)

B. ୟୁ ନିଭର୍ସାଲ (Universal)

C. ୟୁ ନିଟ (Unit)

D. ୟୁ ଜର (User)

Question Type : MCQ
Question ID : 4410091426484
Option 1 ID : 4410095634516
Option 2 ID : 4410095634518
Option 3 ID : 4410095634515
Option 4 ID : 4410095634517

Status : Answered
Chosen Option : C

Q.95 ଡିଲିଟ (Del) କୀ' ର କାର୍ଯ୍ୟ କ'ଣ ଅଟେ?

Ans A. କର୍ସର ପରେ ଥି ବା ଟେକ୍ସଟ ଡିଲିଟ କରିବା

B. କର୍ସରକୁ ଆରମ୍ଭକୁ ମୁଭ କରିବା

C. ସିଲେକ୍ଟ ହୋଇଥି ବା ଟେକ୍ସଟକୁ କପି କରିବା

D. କର୍ସର ପୂର୍ବରୁ  ଥି ବା ଟେକ୍ସଟ ଡିଲିଟ କରିବା

Question Type : MCQ
Question ID : 4410091420578
Option 1 ID : 4410095611234
Option 2 ID : 4410095611235
Option 3 ID : 4410095611236
Option 4 ID : 4410095611233

Status : Answered
Chosen Option : A

Q.96 ଯଦି ଜଣେ ୟୁ ଜର ଏକ 50-ପେଜ ବିଶିଷ୍ଟ MS ୱାର୍ଡ ଡକ୍ୟୁମେଣ୍ଟର କେବଳ 5 ରୁ  10 ପେଜ ପ୍ରିଣ୍ଟ କରିବାକୁ ଚାହାଁ ନ୍ତି,
ତେବେ Print ଡାଏଲଗ ବକ୍ସରେ କେଉଁ  ସେଟିଂକୁ ଡିଫଲ୍ଟ ସେଟିଂରୁ  ପରିବର୍ତ୍ତନ କରିବାକୁ ପଡିବ?

Ans A. Paper Size

B. Collated

C. Print All Pages

D. Number of Copies

Question Type : MCQ
Question ID : 4410091429870
Option 1 ID : 4410095647805
Option 2 ID : 4410095647807
Option 3 ID : 4410095647806
Option 4 ID : 4410095647804

Status : Answered
Chosen Option : D
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Q.97 କେଉଁ  MS-ପାୱାରପଏଣ୍ଟ 2020 ଅପସନ ପ୍ରେଜେଣ୍ଟ କରିବା ପୂର୍ବରୁ  Slideshow Settings କନଫି ଗର କରେ?

Ans A. View → Slide Master

B. Slide Show → Set Up Slide Show

C. Insert → New Slide

D. Design → Slide Size

Question Type : MCQ
Question ID : 4410091448368
Option 1 ID : 4410095721963
Option 2 ID : 4410095721961
Option 3 ID : 4410095721962
Option 4 ID : 4410095721960

Status : Answered
Chosen Option : C

Q.98 ୱିଣ୍ଡୋଜରେ Alt + Tab ପ୍ରେସ କରି ବାରମ୍ବାର Tab ପ୍ରେସ କରିବା ସମୟରେ Alt କୁ ହୋଲ୍ଡ କଲେ କେଉଁ  ୱିଣ୍ଡୋଜ
ଲିଷ୍ଟ ଡିସପ୍ଲେ ହୁଏ ଏବଂ କେଉଁ  ମାନଦଣ୍ଡ (criterion) ସେଗୁଡିକର କ୍ରମ ନିର୍ଦ୍ଧାରଣ କରେ?

Ans A. ଟାଇଟଲ ଅନୁଯାୟୀ ବର୍ଣ୍ଣମାଳା କ୍ରମରେ ସର୍ଟ ହୋଇଥି ବା (sorted) ସମସ୍ତ ଓପନ ବ୍ରାଉଜରର ଏକ ଲିଷ୍ଟ

B. କେବଳ କ୍ରିଏସନ ଟାଇମ ଅନୁସାରେ ସର୍ଟ ହୋଇଥି ବା (sorted) ମିନିମାଇଜ ୱିଣ୍ଡୋଗୁଡ଼ିକର ଏକ ଲିଷ୍ଟ

C. ସାଇଜ ଅନୁସାରେ ସର୍ଟ ହୋଇଥି ବା (sorted) ପ୍ରାଇମେରୀ ମନିଟରରେ କେବଳ ଦେଖାଯାଉଥି ବା ୱିଣ୍ଡୋଗୁଡ଼ିକର ଏକ ଲିଷ୍ଟ

D. ଶେଷ ଥର ପାଇଁ  ଆକ୍ସେସ ହୋଇଥି ବା (ନିକଟ ଅତୀତରେ ବ୍ୟବହୃତ ୱିଣ୍ଡୋ ସର୍ବପ୍ରଥମେ ରହିବ) ସମୟ ଅନୁସାରେ ଅର୍ଡର ହୋଇଥି ବା
(ordered) ସମସ୍ତ ଓପନ ୱିଣ୍ଡୋର ଏକ ଲିଷ୍ଟ

Question Type : MCQ
Question ID : 4410091453334
Option 1 ID : 4410095741621
Option 2 ID : 4410095741624
Option 3 ID : 4410095741623
Option 4 ID : 4410095741622

Status : Answered
Chosen Option : A

Q.99 ଏକାଧିକ ସ୍ଥାନରେ ସମାନ ସୂଚନାର ପୁନରାବୃତ୍ତି କରିବା କହିଲେ ଆପଣ କ’ଣ ବୁଝନ୍ତି?

Ans A. ଡିଲେଟିଙ୍ଗ ଟେକ୍ସଟ

B. କପିଙ୍ଗ ଟେକ୍ସଟ

C. ଫର୍ମାଟିଂ ଟେକ୍ସଟ

D. ଇନସର୍ଟିଙ୍ଗ ଟେକ୍ସଟ

Question Type : MCQ
Question ID : 4410091450615
Option 1 ID : 4410095730920
Option 2 ID : 4410095730919
Option 3 ID : 4410095730918
Option 4 ID : 4410095730921

Status : Not Answered
Chosen Option : --
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"

Q.100 ଇମେଲ ମାଧ୍ୟମରେ କୌଣସି ଡକ୍ୟୁମେଣ୍ଟ କିମ୍ବା ଇମେଜ ଆଟ୍ଟାଚ କରିବା ପାଇଁ  ସାଧାରଣତଃ କେଉଁ  ବଟନ ବ୍ୟବହାର
କରାଯାଏ?

Ans A. Insert → Attachment (Paperclip Icon)

B. Add Signature

C. Mark as Important ​

D. Reply → Forward

Question Type : MCQ
Question ID : 4410091464871
Option 1 ID : 4410095787683
Option 2 ID : 4410095787682
Option 3 ID : 4410095787685
Option 4 ID : 4410095787684

Status : Answered
Chosen Option : A
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